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Chapter 1  
Introduction 

Part I provides an introduction and an overview to the Agile e6 Upgrade Tool. It includes 
the following chapters: 
� Overview of Upgrade Tool 

� Architecture 

� Upgrade process 

� Additional Documentation 

 

Overview 
The Upgrade tool allows a direct upgrade to Agile e6.0 from earlier releases (CADIM/EDB 2.3.2 or 
higher, axalant 2000 SPx, Eigner PLM 5.x ). 

The Upgrade Tool addresses experienced project engineers and PLM administrators with 
customizing and database experience. Do not use the tool without the necessary knowledge. Read 
the complete manual in order to get all necessary information. Do not attach to or even change 
the production system. Always work on a copy of the production database dump. Avoid working 
on production computers to exclude any influence on the system. Never insert database 
connections of production database users in any configuration file or script except for exporting 
the dump or a source for copying tables (Production Database). 

Do not use the software in any situation where significant damage to property or business could 
occur from a software error. In no event will AGILE or any other party who has been involved in 
the creation, production or delivery of the software be liable for special, direct, indirect, 
incidental, punitive or consequential damages, including loss of profits, revenue, business, 
goodwill, data or computer programs or inability to use the software, however caused and 
regardless of the theory of liability even if AGILE or such other party has been advised of the 
possibility of such damages. 

Architecture 
The Upgrade Tool comprises the following components 

� The upgrade tool itself 

� Control and Log files in XML 

� GUI 
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Upgrade tool 
The upgrade tool is implemented in Java. It accesses the databases directly using a JDBC 
connection. Through JRE to XML and log files and command scripts which call SQL scripts are 
executed. 

Control and Log files in XML 

The configuration of all upgrade steps is stored in a set of xml control files. When executing a step, 
a log files is created in XML containing the error messages.  

A set of control and log files is defined for each upgrade step. The location of the files is stored in 
the main configuration file upgrade\conf\ApplicationParameter.xml. 

The log and error files are mainly in XML format and can be found in the directory 
Upgrade/log/… 

For all actions (see Action tab) that compare table content (Create files) and change repository 
information (Perform Insert, Update, Delete) a common set of control and log files is used. 

You can convert the XML files created as log and configuration files to HTML and view them with 
a browser. The batch file xml2html.bat creates HTML files for insert, update and delete for each 
table. This function is available on Windows platforms only. 

Note: You need memory for approximately sixth times the XML file size! 

See Annex for a description on converting XML files to HTML. 
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GUI  

The user can execute the migration steps easily from the user interface of the Upgrade Tool.  

 

Upgrade Process 
To upgrade from an earlier release to Agile e6. you carry out the following steps:  

� Preactions 
where you make a copy of your original production environment 

� Performing Customizing upgrade  
Customization and configuration stored in the database is updated to Agile e6.0. 

� Test phase 

� Taking over your production data to finish the process. 
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Preactions on original production environment 

Make a copy of your production database dump . Do not attach your production system. Always 
work on a copy of your data. 

Start the upgrade on this copy. The minimum passing time will be 4-5 hours (depending on the 
system, main parameter is memory!). 

The Upgrade Tool will create a dump on which you can run Agile e6.0. This dump is not error 
free. You have to check all functionalities and clear out the errors caused by setting up the upgrade 
tool. 

Customization Upgrade 

The Upgrade Tool opens three database connections: 

� Source Master (Source reference):  
A CADIM/EDB / axalant 2000 / Eigner PLM dump with Agile e6.0 ”n” table structure. 
The necessary SQL scripts have been executed to adjust the DataView tables. LogiView 
standard models have been deleted so that standard LogiView models will be completely 
reloaded. This is already done in reference dumps delivered with this upgrade tool. 
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Target Master
Eigner PLM50
DBU:„plm50“

Source Master
axalant SPx

DBU:„AXASP3REF“

Eigner PLM 
Upgradetool

modify

compare

customerspecific

DBU: „CUSTOMER“

 

� Target Master (PLM reference ):  
This is an standard Agile e6.0 dump. 

� Customer (CUSTOMER): 

The customer dump has the version of the Source Master at the beginning of the upgrade 
process. At the end it has the version of the Target Master. 

XML-files

SQL-scripts

edb234upgref plm50upgref

CADIM/EDB 2.3.4

Upgrade
Toollogfiles

customercustomer
PLM50

process

 

The Upgrade Tool selects each row from the Source and the Target Master dump, compares the 
data sets from both dumps to identify the differences and checks if the customer has modified 
these data. 

The upgrade action (Insert, Update, Delete) is determined for each record and the information is 
stored in a set of XML files. The migration rules are listed in the Annex. 

The Upgrade Tool is only able to compare tables with the same table structure. Therefore the 
DataView tables in the reference dumps (edb234upgref …) have Agile e6.0 structure. The 
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customer dump will be formatted during the upgrade (execution of SQL scripts and step 
synchronize repository).  

The customization upgrade is generally split into two steps: 

� Comparison of the data sets from the different dumps and storing the changes in an XML 
file for the three possible operations: delete, insert and upgrade (e.g.: dtvdel.xml, 
dtvins.xml, dtvupg.xml). 

� The Upgrade Tool reads the XML information and performs the corresponding SQL-
statements. After this step the changes are available in the Agile e6.0 dump. 

Test 

Take over the data from the production system for a first test and let the user test all 
functionalities, maybe during training. If errors occur, remove them via customizing. Not 
everything might be done automatically. 

If testing does not raise any error you can plan to change to productivity. Shut down your 
CADIM/EDB, axalant or Eigner PLM system. Take over your data from the production system 
(and the files!) again and Agile e6.0 is your production system. 

Transfer Data from production system 

All tables containing production data like document and item master data are copied from the 
production system to your Agile e6.0 installation. They will be adapted so that you can work on 
this data within Agile e6.0. 

After finishing the test of the new custom-specific Agile e6.0 functionality, the customer can go 
live with the new version. 

During the test period a lot of new data is created in the production system. This data must be 
copied again from the old production system into the new environment and adapted to the new 
Agile e6.0 table structure. This step is called Takeover Production data.  

The Upgrade Tool supports the following actions: 

� Definition of a list of reference tables containing production data. 

� Dropping the reference tables in the customer environment and copy the table from the 
production system. 

� Adapting the table structure to Agile e6.0. 

� Post-actions like migrate production classification data. 

For this step the tool opens two database connections: 

� Production Database 

This database connection is used as source for the tables copied into the new Agile e6.0 
environment. No changes are made in the production database.  

� Customer 

Connection to the new production environment. The reference tables will be dropped. This 
becomes the new production Agile e6.0 environment. 
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Special Upgrade: Classification 
If you use the Classification module, the following steps are necessary in addition to the standard 
upgrade process.  

� Adapt original production environment 

� Upgrade Pool Concept 

� Migration concept 

� Take Over Data from the production system 

Adapt original production environment 

Since Agile e5.0 UIC and GIC <=1000 are reserved for the standard development. Existing users 
or groups use such C_IC must be migrated to an higher Value. This migration must be executed 
in your production system before you start any other upgrade activity. 

This update can be very time consuming ! In a big customer dump it takes 1h/6 users. To solve the 
time conflict, breakdown the update into different sub sets and try to run it in parallel . 

1. To do this Adapt the following statement in the sql script 

INSERT INTO TEMP_U (OLD_U) SELECT C_IC FROM T_USER a 
WHERE 
C_IC > 200 AND C_IC < 1000 AND C_NAME NOT LIKE 'EDB%' AND  
C_NAME NOT LIKE 'DEMOEP%'; 

2. To execute the  UIC/GIC Migration execute the   

PC  RUN update_uic.cmd 
UNIX  run update_uic.sh 

Upgrade Pool Concept 

With Agile e5.1 a new classification concept (Pool concept) has been introduced. If you are 
upgrading from CADIM and axalant to Agile e6.0, you need to adapt the classification data from 
the ATT concept to the new pool concept. The following table shows a comparison between the 
old ATT Concept and the new Pool concept:  

Overview ATT concept (Old) Overview new Pool concept 

� Attributes are defined class specific in 
the ATT concept 

� Domain values for an attribute are 
defined in static menus 

� No release procedures and status 
management for classes and 
attributes 

� Attributes can be defined class 
independent 

� Pool attributes can be assigned to more 
then one class  

� Domain values  for a pool attribute can 
be stored in special domain table 

� For every class can be specified which 
domain value is valid 

Note: Migration of changes in the attribute inheritance must be executed for all version  

7 



Agile e6.0 

Migration concept 

The migration includes  

� Merge of Attribute definition 

Attributes  are considered as identical if  the following values are identical  

z C_LETTER  

z C_TITLE 

z C_TYPE 

If you have defined C-Letter and C_TITLE as multi language fields(Standard beginning with 
axalant 2000) you define with the Parameter  DB language which language is used as basic for 
the merge. (see installation and configuration manual for more information how to define 
parameters) 

� Initial Load  of the attribute value pool including the activation  of the attributes for 
special classes 

� Update classification lists 

� Update used field name  

� Set of attribute ATT_VAL_REF in the classification Lists 

� Update field and Mask definition (if you have defined own forms for classes 

 

E D B -G R O U P
T _ G R O U P _ D A T
C lassific . G ro u p s

E D B -C L A A T T R
T _ C L A _D A T

C lass  A ttrib u tes

E D B -A T T R V A L
T _A V L _ D A T

A ttrib u te  V alu es

E D B -F IE L D
N o T able

N u ll E n tity

E D B -F IE L D
N o  T ab le

N u ll E ntity

S T R
T _ G R P _ F L D

S T R
T _ G R P _ C L A

E D B -C L A -A V L
E D B _ID

S T R
T _ A V L _ F L D

S T R
T _ A V L _ H IS

S T R
T _ C L A _ H IS

E D B -H IS T O R Y
N o  T ab le

N u ll E n tity

S T R
T _ G R P _H IS

  
If possible do not create or modify basic definition of classes and attributes between 
customization upgrade and take over data from production system. 

This influences the migration steps must be executed after the takeover process. 

� No new classes and attributes are created 
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Only classification list tables must be defined as reference table 

z T_GRP_ART 

z T_GRP_DOC 

z T_GRP_ORD 

z T_GRP_PRO 

� Customers have created new classes and attributes in the production system after the 
customization upgrade  

In addition to the classification list tables classes, attributes and domain values must be 
copied and migrated  

z T_GROUP_DAT 

z T_GROUP_STR 

z T_GRP_FLD 

Take Over Data from the production system  

If you created new users and or groups since the date when the dump was exported form 
production system the following DataView-tables must be migrated !  

� T_USER,  

� T_GROUP, 

�  T_GRP_USR, 

�  T_PROFILE 

� Related tables of the PLM – person management  

Attention: new plm- or axalant-user like EDB-WFL, EDB-DFM, EDB-DDM, EDB-GDM, EDB-
EER, DODEKERNEL will be lost. Export these users first with the binary loader (T_USER, 
T_GROUP, T_GRP_USR) and reload them after the upgrade. Table T_DEFAULT should be 
migrated by the loader (import/overload) otherwise new defaults will be missing. 
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Chapter 2  
Installation 

Prerequisites 
The Upgrade tool runs on the following software: 

� Server platforms 

z Windows 2003 Server 

z Unix (all platforms supported by Agile e6.0) 

� Memory 

z The upgrade tool needs at least 512 MB of memory 

� Databases 

z Oracle 8.1.7 / 9.2.0.4 or higher (Source database) 

z Oracle 10.1.4 (Target database) 

The best performance is reached when installing the upgrade tool on your database server. It is 
also possible to work on any machine in the LAN. The machine should have at least 1GB memory. 

To install the Upgrade Tool you need at least  

� 250 MB disk space for the software and generated log and data files 

sufficient disc space to store copies of your production database and the reference dumps on your 
database. 

Installing the Upgrade Tool 
1. Extract the software (upgrade.zip) to a folder Upgrade on your database server. 

The following structure is created: 

10 Upgrade Tool 3.0 



Chapter 2 Installation 

 

The file upgrade\cmd\upg_env.cmd (PC) or upgrade/scripts/upg_env.sh (Unix) contains the 
environment definition for your upgrade process.  

2. Adapt the following environment definitions in upg_env.sh / upg_env.cmd: 

• JAVA_HOME  
At least JRE 1.4.2 is required by upgrade tool.  
In the standard configuration of the file the JRE of the Agile e6.0 installation is used 
for that. 

• ORACLE settings 
Make that Oracle 10.1.4  environment is set before proceeding with upgrade.  

To check the environment for UNIX execute the following commands  

env|grep ORA 

Output should look like this: 
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Chapter 3  
Configuration of Upgrade Tool 

Chapter 3 provides the description of how to configure the upgrade tool . It includes the 
following chapters: 
� Check Database settings 

� Prepare Environments 

� Define Database Connections 

� Define Parameters 

� Configure control and log files 

� Configure take over data from the production system 

� Special Configuration: Classification 

 

Check database settings 

Check database settings in Oracle 

The Upgrade Tool needs a well-configured database to provide a good performance. The Oracle 
standard database settings are not sufficient to run the program within the stated time. 

1. Check the Oracle Parameter and verify that at least the following minimum values are set in 
your database instance: 

� db_cache_size  >= 200 000 000 (200MB) 

� shared_pool_size >= 100 000 000  100Mbytes 

� log_buffer >= 163840 3*64 Kbytes 

If database memory consumption is too small, adapt the values. 

If you use the server parameter file spfile (like in the Agile e6 standard installation), execute 
the following commands to change the values of the initialization parameters.  

� Login into sqlplus as user  sys 
SQL>ALTER SYSTEM SET <parameter name>=>Value>  SCOPE=BOTH 
 
Note: Do not change the values of production systems. Make a copy of the initialization 
file and adapt the values.  

� Read the Oracle online manuals and the Oracle10.1 installation manual from Agile in 
addition.  

Oracle needs physical memory. If the system starts swapping or paging, the Oracle 
performance degrades or causes errors. Examine your free physical memory and prevent the 
OS from swapping. 
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Some UNIX systems have maximum values for shared memory. Refer to the installation 
instructions before changing any value.  

2. Check the SQL Net configuration (Oracle only). 

The network domain is part of different oracle settings. Please check if the domain is 
consistently used for the following settings: 

� Global Database 

� Service name 

� Listener.ora 

� Default domain name 

Global Database name 

� Login as user sys and check the global database name.  

The name should contain the network domain. 

Sqlplus  <system>/<db_passowrd>@<db_service> 
SQL>select * from global_name; 

Example 

GLOBAL_NAME ------------------------ 
PLM.WORLD 

The example uses the default network domain in world. Also possible are values like 
agile.agilesoft.com. 

Change the global database name login to SQL plus and execute the following commands: 

SQL>alter database global name plm.agile.agilesoft.com 

Service name 

Service name in the SQL net configuration file  tnsnames.ora network in the directory 
$ORACLE_HOME/network/admin 

The service name must also include the network domain. Please check the setting in the sqlnet 
configuration file tnsnames.ora 

� Change to the directory $ORACLE_HOME/network/admin  

� Open the file tnsnames ora and check if the service name is fully defined. That means the 
name contains the  same network domain as the global database name. 

PLM.WORLD = 
  (DESCRIPTION = 
    (ADDRESS_LIST = 
      (ADDRESS = (PROTOCOL = TCP)(HOST = localhost)(PORT = 1521)) 
    ) 
    (CONNECT_DATA = 
      (SERVICE_NAME = PLM.WORLD) 
    ) 
  ) 
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listener .ora 

� Check if the global database name in the section SID_List of the listener configuration file 
contains also the same fully qualified global database name. 

SID_LIST_LISTENER_PLM = 
  (SID_LIST = 
    (SID_DESC = 
      (GLOBAL_DBNAME = PLM.WORLD) 
      (SID_NAME = plm) 
    ) 
  ) 

LISTENER_PLM = 
  (DESCRIPTION = 
    (ADDRESS = (PROTOCOL = TCP)(HOST = localhost)(PORT = 1521)) 
  ) 

Service name 

Default domain name in SQL net configuration file is sqlnet.ora 

The default setting for the network domain in the sqlnet.ora file should be the same.  

� Change to the directory $ORACLE_HOME/network/admin and Open the file sqlnet.ora 
and check the default domain settings. 

names.default_domain = world 

Prepare environments 

Prepare reference environments 

The upgrade tool needs the following database environments/users: 

Source master  CADIM/EDB, axalant or Agile 5.x reference dump 

Target master Agile e6.0 reference dump 

Customer customer dump  

 
A separate database user is needed for each environment.  

1. Download the necessary reference dumps from Agile support website and unzip them in the 
upgrade/dumps directory. 

Note: Do not change the names of the downloaded reference dump files. The dumps cannot 
be imported automatically if a different name for the dump file is used. 

2. Check if the following table spaces (Oracle) or file groups (SQL Server) exist in your database  

z edb_tmp  

z edb_tmpidx  

z edb_lob 
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If one of them does not exist they have to be created:  

Oracle 

z Change to the directory upgrade/ora/sql  

z Adapt file names, paths and file size in the script cre_axa_tbs.sql  

z Login as user system to sqlplus and execute cre_axa_tbs.sql 

z sqlplus system/<password>@agile 

z SQL> @cre_axa _tbs.sql 

3. Import reference and customer dumps 

Note: For importing the dumps, do not change the table space names, because the created 
table statements on tables containing a blob clause will fail if the original table spaces EDB, 
EDB_IDX and EDB_LOB do not exist 

z Copy your customer dump file in the directory upgrade/dumps 

z Rename the file to <db_user>.dmp where <db_user> is the user name of your customer 
dump (e.g. customer.dmp) 

z Run imp_dmp.cmd (PC) or imp_dmp.sh (UNIX) to restore the original and target 
master databases (oracle and SQL Server) and the customer database (oracle only). To 
create your customer environment in SQL Server use Backup/Restore functionality of 
SQL Server. 

4. Create statistics for  all involved database schemas 

z Check Language settings 
Because of an Oracle bug the setting for  the environment variable NLS_LANG must be  
AMERICAN_AMERICA.WE8ISO8859P15. Otherwise statistics will not computed 
correctly. 

z Login as user with dba privilege and perform analyzing. 
 sqlplus> EXECUTE  DBMS_STATS.GATHER_SCHEMA_STATS (‘<schema>', N); 
      N is the sample %  for statistics collection(use 100%) 

Define Database Connections 
The definition of the database connections is done in four steps:  

z Source Master: 
Standard reference dump corresponding to the version of CADIM / axalant / Agile e-
series customer dump 

z Target Master : 
Standard reference dump for desired target version 

z Customer: 
Database environment containing CADIM / axalant / Agile e5.x customer data 

z Production Database: 
Database environment containing production CADIM / axalant / Agile e5.x . This 
connection is used as the source for taking over production data 
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Define Source Master/Target Master/Customer Connections 

1. Start Upgrade Tool 

PC:  Run start_upg.cmd 

UNIX:  Run start_upg.sh 

The following screen will be opened:  

 

2. Select the respective tab  

z Source Master 

z Target Master 

z Customer 
Important: Make sure not to use a production database dump! 

Do not change this connection to a different CADIM /axalant / Eigner PLM dump. The 
reference dumps are modified. Use the database dumps delivered with the Upgrade Tool. 
Only the reference dumps have the Agile e6.0 table format but CADIM/axalant/Eigner PLM 
contents. Standard LGV models are dropped! 
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3. Enter the following information: 

Database 
selection 

Select the desired version 

Host host name of database server 

Port port number of Oracle listener (default 1521 ) or SQL Server 
port number (default 1433) 

SID Oracle_SID (uppercase) or database name for SQL Server 
(lowercase) 

User database user name 

Password  password of database user 

Connection String Service name, which is used to run SQL*PLUS commands on 
the machine the upgrade tool is installed on. 

Use fully qualified name including the network domain, f.e.  
plm.aile.agilesoft.com 

Tablespaces: 

Note: Name of used tablespaces (Oracle - uppercase) or file groups (SQL Server - lowercase) 

Table Default EDB* 
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Index Default EDB_IDX* 

LOB Default EDB_LOB* 

Temporary 
table 

Default EDB_TMP* (edb on SQL Server until axalant 2000 SP3 
) 

Temporary 
index 

EDB_TMPIDX* (edb_idx on SQL Server until axalant 2000 
Sp3) 

 
4. Test the connection using the Button “TEST 

Note: The Java Connection can only be tested in Version 3.0. The Service Connection via 
SQL Net is not tested with the Version 3.0 of the Upgrade Tool.  

Define Production DB 

This is the database connection to the production system. This connection is used as source for 
the transfer of production data.  

Compared to other connection definition only the service name of the sqlnet connection must be 
defined (defined in tnsnames.ora e.g. agile). 

1. Select the tab Production DB 

 

2. Make the following entries 

Parameter Name Description 

Service Name Oracle service name including network domain e. g. AGILE.AGILESOFT.COM. 

Service name must be defined in tnsnames.ora 
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SID Oracle_SID (uppercase) or database name for SQL Server (lowercase) 

User database user name 

Password  password of database user 

 

3. Test the connection using the Button “TEST 

Define Parameters 
Additional parameters which are available in the file ApplicationParamter.xml can be viewed and 
edited. 

1. Select the tab Parameter 

 

2. Review and correct the entries if necessary and check the following table for valid entries. 

With the “Compute” button, the right values can be determined. Always check the computed 
values. 

Parameter name Description 

PLM-Version The customer dump version 
Following values are valid: 

1 = CADIB/EDB 2.3.x 
2 = AXALANT SP1 
3 = AXALANT SP2 
4 = AXALANT SP3 
5 = PLM 5.0 
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6 = Agile e6.0 

Logiview Timestamp A Timestamp 
All logiview items with a change date after this time point will be deleted. You 
can adapt this value manually. Following values are possible: 

CADIM/EDB 2.3.2 – 19990329094555 
CADIM/EDB 2.3#3 – 19990707174038 
CADIM/EDB 2.3#4 – 19990707174038 
CADIM/EDB 2.3#5 – 20000329161725 
axalant2000 SP1 – 20001109140557 
axalant2000 SP2 – 20010723102350 
axalant2000 SP3 – 20011113092600 
axa2000 SP3 PA1 – 20020808110309 
Eigner PLM 5.0  - 20020830153411 

The version must correspond to your customer dump version 

Classification –
Controlfile 

A file name of the control file for the customer dump in the present case 
Valid entries are: 

cla_ctl.xml (used for CADIM/EDB and no multi language fields for classification 
attributes c_letter and Class 

cla_ctl_with_repl.xml used for CADIM/EDB and no multi language fields for 
classification attributes c_letter and Class, database replication is activated) 

cla_ctl_with_multi_lang.xml(axalant 2000 or higher ,c_letter_c_class defined as  
multi language fields) 

cla_ctl_with_multi_lang_repl.xml (axalant 2000 or higher ,c_letter_c_class 
defined as  multi language fields; database replication is activated) 

Database Language Language for the database dump. This influences the migration of the 
classification data.  
Values: German, English 
Default:  German 

Level Status, that is set during classification upgrade for records in the tables t_cla_dat 
(pool attributes), t_group_dat(classes) 

Replication server Null or a valid name of the database server  

should be used of an implemented database replication to the environment be 
migrated 

Configure control and log files 
A set of control and log files is defined for each upgrade step. The location of the files is stored in 
the main configuration file upgrade\conf\ApplicationParameter.xml.  

Control and log files for comparing/updating repository tables 

For all actions (see Action tab) that compare table content (Create files) and change repository 
information (Perform Insert, Update, Delete) a common set of control and log files is used.  

Parameter Name Description Example 

Datadictionary Description of data model, defining the objects and their 
relationships for upgrade.(all Modules) 

upgrade\data\dtv\dtv
DD.xml 
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Special.xml Contains information about a table that must be renamed. For 
DTV- Upgrade only (DTV Upgrade only) 

upgrade\Conf\special.
xml 

Deletefile Deleted records in xml format.(all Modules) upgrade\Data\dtv\dtv
_del.xml 

Insertfile New records in xml format.(all Modules) upgrade\Data\dtv\dtv
_ins.xml 

Updatefile Updated records in xml format.(all Modules) upgrade\Data\dtv\dtv
_upd.xml 

Errorlog Errors (all Modules) upgrade\Data\dtv\dtv
_err.xml 

Infolog Information (all modules)  upgrade\Data\dtv\dtv
_info.xml 

Customizing All conflicts for specific columns, which can be not handled by 
the upgrade tool automatically are written to customizing.log 

(DTV-Upgrade only) 

upgrade\Data\dtv\cust
omizing.log 

EdbID Replace Generated during dtv upgrade, define the updates for the new 
foreign key references (based on new added EDB_ID’s) 

(DTV-upgrade and synchronize Repository) 

upgrade\Data\dtv\edb
_id_replace.xml\ 

Note: If necessary update the name and the location of the control and logfiles for the 
actions. 

Control and log file for Synchronizing repository 

This step uses a set of specific control and log files. If the step is executed again, the log files will be 
saved and then overwritten. The saved log files extended with a consecutive number for every 
version ( e.g. sync_all001.log — sync_all002.log — sync_all001.log) 
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Parameter 
Name 

Description Example 

sql All SQL statements for creating and altering database objects 
are logged. This file is created in step “synchronize 
repository”. 

upgrade\data\sync\sync_sql.lo
g 

all Store all log information. This file is created during step 
“synchronize repository”. 

upgrade\data\sync\sync_all.lo
g 

data Table definition. This file is created during step 
“synchronize repository". 

upgrade\data\sync\sync_data.l
og 

special XML file containing special definitions for repository 
upgrade like move of fields. 
Default values for the new mandatory columns. 

upgrade\conf\special.xml 

analysis Analysis.log store inconsistencies between DataView table 
definition and physical tables. This file is created in the step 
”analyze repository” 

upgrade\data\sync\sync_analy
sis 

Control file Not used for upgrade to Agile e6.0  

 

Note: If necessary update the name and the location of the control and logfiles for the 
actions 
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Configure special.xml for synchronizing repository  

In the step Synchronize Repository, the following functionality is executed: 

� Set static and dynamic default values for new mandatory columns or columns changed 
from null to not null 

� Rename tables 

� Move fields 

� Change data type of a field 

These functions need a specific configuration. This information is stored in 
upgrade\conf\special.xml. The delivery contains a preconfigured special.xml which define 
standard setting for all expected cases. 

Very often the customer dump contains inconsistency, so that in the analyze mode the tool will 
add entries to the special.xml file. You then need to reviewed and adapted the configuration. 

If the special.xml is damaged, copy a original special.xml file  from the template directory 
(upgrade\conf\template) into the directory Upgrade\Conf and start the synchronization again. 

Set Static and dynamic default values 

Static values 

To set a static value the configuration looks like  

<FieldDefault> 
<FieldName>T_TRE_DAT.CUR_FLAG</FieldName> 
<FieldType>S</FieldType> 
<FieldSize>1</FieldSize> 
<DefaultValue> 
<Value>n</Value> 
</DefaultValue> 
</FieldDefault> 

In this case the column T_TRE_DAT_CUR_FLAG is set to ‘n’. 

Dynamic values 

The field values can be computed dynamically based on 

� a Java function 
preconfigured function to use the number server to set values are available (see example) 

� SQL Statement 
 

Example:  

sql statement is used to compute field value 

<FieldDefault> 
<FieldName>T_CTX_DAT.EDB_SEQ</FieldName> 
<FieldType>I</FieldType> 
<FieldSize>4</FieldSize> 
<DefaultValue> 
<Select>DISTINCT (SELECT COUNT(*) FROM T_CTX_DAT T WHERE T.C_ID &lt;= 
thisRec.C_ID)*10</Select> 
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<Where>C_ID &gt; 0</Where> 
</DefaultValue> 
</FieldDefault> 

Example  

Java function is used to compute field values (get a new number from the number server and 
fill in the value)  

<FieldDefault> 
<FieldName>T_MASTER_DOC.EDB_ID</FieldName> 
<FieldType>I</FieldType> 
<FieldSize>10</FieldSize> 
  <DefaultValue> 

<Function>GetNewEDBID(EDBEDBID)</Function> 
  </DefaultValue> 
</FieldDefault> 

Rename tables 

Specifies the old and the new name for tables.  

If you have used DFM already, the following tables must be renamed (for upgrade from cadim to 
Agile 6 only). 

z T_EER_SIT 

z T_EER_SIT_STR 

z T_EER_SIT_MED 

<RenameTable>  
 <TableName>T_EER_SIT</TableName>  
 <NewTableName>T_DDM_SIT</NewTableName>  
</RenameTable>  

<RenameTable>  
 <TableName>T_EER_SIT_STR</TableName>  
 <NewTableName>T_DDM_SIT_STR</NewTableName>  
</RenameTable>  

Move fields 

This option allows to move a column of a table inclusive stored values to a new location. To move 
a field you have to specify: 

� Source field (<table_name>.<column_name>) 

� Target field (<table_name>.<column_name>)and 

� Path (join condition between old and new table) 

The sample configuration files show 3 different possibilities to move field values to a new location. 

    <!-- Example transfer from typetable to entitytable. --> 
 <MoveField> 
   <SourceField>T_DOC_DRW.CRE_USER</SourceField>  
   <Path>T_DOC_DRW.C_ID_2</Path>  
   <Path>T_DOC_DAT.C_ID</Path>  
   <DestField>T_DOC_DAT.CAX_CRE_SYSTEM</DestField>  
 </MoveField>  
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    <!-- Example transfer from entitytable to entitytable via 
releationtable. --> 
 <MoveField> 
   <SourceField>T_MASTER_DAT.PART_ID</SourceField>  
   <Path>T_MASTER_DAT.C_ID</Path>  
   <Path>T_MASTER_DOC.C_ID_1</Path>  
   <Path>T_MASTER_DOC.C_ID_2</Path>  
   <Path>T_DOC_DAT.C_ID</Path>  
   <DestField>T_DOC_DAT.CAX_CRE_SYSTEM</DestField>  
 </MoveField>  
    <!-- Example transfer in table. --> 
 <MoveField> 
   <SourceField>T_MASTER_DAT.PART_ID</SourceField>  
   <DestField>T_MASTER_DAT.EDB_ICON</DestField>  
 </MoveField>  
</SpecialCases> 

If you have a cax interface installed already, please check if one of the columns used to store cax 
specific information is defined as a document-type-table-column. These columns are now part of 
the standard axalant data-model and included in the document master table 
T_DOC_DAT.(migration from CADIM to Agile e6.0) 

An example configuration file special_move.xml containing definition of moved fields are stored 
in the template directory …\upgrade\conf\template. 

Change data type of a field 

The upgrade tool allows changing the type definition of columns. The following type changes are 
possible: 

� IntegerÆString 

If the value of a column for all records is null then also incompatible data type changes can be 
executed, for example  STRING-->Integer   

Cutting a string field is only possible if no record contains a longer value. Please check max length 
of stored values directly with SQL. 

You have to replace “false” by “true” to confirm the change. The type definition “oldType” comes 
from the database; “newType” is the DataView definition. (T_FIELD. C_FORMAT) 

FieldChange>  
 <FieldName>T_DOC_DAT.FOO</FieldName>  
 <ConfirmChange oldType="S80.0" newType="S40.0">false</ConfirmChange>  
</FieldChange> 
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Special Upgrade: Classification 
The following control and log files are used for the classification 

 

 

Parameter 
Name 

Description example 

Control file cla_ctl.xml defines the rules for the classification 
upgrade like data field mapping, merge condition, 
etc. 

upgrade\conf\cla_ctl.xml 

Merge 
conditions  

The file merge_ctl.xml is created during the step 
determine merge conditions and stores the new pool 
attributes and the original class specific attributes. 

upgrade\data\cla\cla_merge_ctl.x
ml 

Action log file  All actions are written to the log file act_log.xml. upgrade\data\cla\cla_act_log.xml 

Errorlog  Is not used yet. upgrade\data\cla\cla_errors.log 
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Configuration file for Special replace.xml 
This configuration files contains definition of sub strings in repository columns which should be 
replace by an other string 

The file can  be found in the directory ../conf/specialreplace.xml 

Example 

Update the strings T_EER_SIT  with T_DDM_SIT in LGC Code 

 

<?xml version="1.0" encoding="UTF-8"?> 
<special> 
 <replace> 
  <table>LV_DT_PRC</table> 
  <field>MAIN</field> 
  <example>T_EER_SIT</example> 
  <replacewith>T_DDM_SIT</replacewith> 
     </replace>  
</special> 

Configure take over data from the production system 
Select the tab Takeover production data and review the configuration and Log files for this step  
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Parameter 
Name 

Description Example 

Reference Data Data Ref_data.xml defines which tables are 
proceeded during the step takeover production 
data (s. chapter “Take over of reference data”). 

upgrade\conf\ref_tables.xml 

Reference tables  Ref_tables.xml contains the default list of 
reference tables. 

upgrade\con\templates\ref_tables.xml 

Takeover Log  Information about all executed commands. upgrade\log\tko_takeover.log 

Takeover err 
Log 

Information about occurred errors. upgrade\log\tko_DataTakeover.sql 

Define reference tables 

1. Select folder Takeover in the Upgrade Tool and press the button Create Ref File. 

The Upgrade Tool will connect to the production database, identify all tables and synchronize 
the information with the predefined list (ref_tables). Only tables with data will be written to 
the file. 

2. To adapt the list, press Edit ref. file  

 

For each table you have to define, if it is a reference table. (ref_data=y.)The called reference 
tables will be dropped in the customer dump and copied in from the production system using 
the connection to the production DB. 

3. Select OK to save the XML file (upgrade/data/ref_data_tab.xml). 

For detail information which tables should be copied please refer document  Overview 
upgrade process. 

28 Upgrade Tool 3.0 



Chapter 4 Migration 

Chapter 4  
Migration 

Performing Customizing Upgrade 
This chapter describes how the Customizing Upgrade is executed interactively. There are different 
scripts available for selection under the Action tab which should be executed in the respective 
order.  

 

Step Run preaction scripts 

This script must be run before the DataView upgrade is run. 

1. Select Run preaction scripts. 

The Command script upg03_preaction_sql.cmd will be executed. This script executes a set of 
SQL scripts (depending on the customer dump version). See Annex file for further 
information. 

2. Click the Run Preaction Scripts button  
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3. Check the created log files that will be stored in the upgrade/log directory.  

The following log files are created  

z Upg03_preaction.sql  
This is the main sql script which includes the calls of other sql script.  

z Log files are written for each executed sql script.  
The log files use the following naming convention  
upg03_%<script name>.log 

A complete list of SQL files which can be executed can be found in the annex  

Step DTV-upgrade 

This script updates the DataView repository. 

If you want to rename tables, you have to specify these tables in the file upgrade/conf/special.xml 
first. Refer to the Installation and Configuration Manual for further information. 

1. Select DTV-upgrade  

2. Click the Create Files button. 

This step takes around 10 min - 4 hours. 
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3. Check log files in the directory upgrade\data\dtv.  

Note: For better readability, it is possible to create HTML files from the XML log files. 

4. Click the Perform Delete, Insert, Update button. 

This step takes about 15 - 40 min. 

5. Check the log files in the directory upgrade\data\dtv 

If an error occurs, check the detail error information in upgrade\log\erorrdetail.log and see 
the error handling information n the Annex file. 

Adapt physic. table definition acc. to DataView table definition 

The table definition in DataView is compared to the physical table structure in the database. 
SQL statements to create and alter database objects are generated and executed automatically. 
The adaptation of the physical data structure will consist of the following steps: 

Step Run before sync scripts 

1. Select run before-sync scripts.  

2. Click the Run before-sync-scripts button. 

The command script upg07_sync_update.cmd will be executed. This script executes a sql 
script. 

3. Check the log files upg07%.log in then upgrade\log directory for possible errors. 
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Step Synchronize Repository 

1. Select Synchronize Repository.  

2. Click the Analyze repository button 

If you run the program in the analyze mode you can see which statements the program will 
perform.  

This creates a special file for defaults and special tasks.  

If the program terminates the process and releases the connection because of a server error, 
drop the special.xml file in upgrade\conf directory and copy the preconfigured template from 
..upgrade\conf\template into the ..\upgrade\conf directory. Restart the process. 

The data and log files are placed in the upgrade\data\sync directory. A detailed Description of 
the errors can be found in upgrade\log\errordetail.log 

This step takes about 1-6 min. 

3. Set defaults and configuration parameters in the file special.xml and save the changes.  

Note Do not change or delete the default settings. 

4. Adapt the following configurations 

z Static and dynamic Default values for columns changed from null to not null 

z Rename tables 

z Move fields 

z Change data type of a field 

For detail description of the correct configuration, please refer the installation and 
configuration manual.  

5. Click the Synchronize Repository button.  

This script executes all changes in the database using the information from file special.xml. It 
takes about 3-20 min. 

Data and log files are stored in directory upgrade\data\sync. 

Check the file upgrade\log\errordetail.log for possible errors. 

Step after-sync-scripts 

1. Select Run After-sync-scripts 

The command script upg08_postactions will be executed. This script executes a set of sql 
scripts. 

2. Check the results in the log file. All log files will be stored in the upgrade\log directory. 

z Upg08_postactions.sql  
This is the main sql script which includes the calls of other sql script  

z Log files for every  executed sql script. The log files uses the following naming 
convention upg08_%<script name>.log 
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Step Run before-common-scripts 

1. Select Run before common scripts 

The command script  upg09_common_get.cmd will be executed. This script starts the sql 
script to save and delete standard LogiView Models.  

2. Check log files in the directory upgrade \log 

z Upg09_common_get.sql  

z  Sql scripts  upgrade\log\upg09%.log 

Note: If an error occurs during LogiView upgrade, restart the script and execute LGV 
Upgrade again. 

Step EDB-UPD 

This step upgrades the Agile e6 Application  Repository. It inserts and upgrades data in the 
application repository of Agile e6. The repository tables are grouped into different upgrade 
modules.  

The following modules are necessary to migrate to Agile e6 

z EDB-upgrade 

z BRW-upgrade 

z DODE-upgrade 

z LGV-upgrade (Logiview 

z WFL-upgrade(Workflow),  

z CHG-Upgrade (Change Management 

z Classification-upgrade(Classification)  

z GDM-upgrade(Office Suite) 

Note: This step needs to be execute for each module except Classification-upgrade.  

1. Select the module e.g. EDB-upgrade 

2. Click the Create file button. 

3. Click the Perform Insert, Update, Delete button 

These steps take about 20 min. 

4. Check the log and data files found in the directory upgrade\data\<module short name>,  

For an error description see the chapter Handling Of Errors” in the Annex.  

Special Upgrade: Classification 
Depending on your source version of the Agile system execute on of the following:  

� Migrate classification data from the ATT concept to the new pool concept ( necessary for 
migration  from CADIM and axalant to Agile e6.0) 

� Migrate changes in attribute inheritance (migration of all source version to Agile e6.0) 
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Migrate class data from the ATT concept to the new pool concept 

1. Check parameters settings for the Classification Upgrade (for detailed information see 
Installation and Configuration manual) 

2. Select Classification-upgrade to start the migration. 

3. Select Determine Merge conditions 

As a result, the file merge_ctl. xml is created. This file contains so-called merge groups. All 
attributes mapped onto the same pool attribute are in the same merge group. 

4. Select Execute Perform merge conditions. 
The file merge_ctl. xml is read. Based on this information all objects and attributes are created 
or updated.  

5. Check the merge and log files. 
These files are located in upgrade\data\cla 

Migrate changes in attribute inheritance 

1. Select Attribute Inheritance to start the migration. 

2. Click the button Perform attribute inheritance to subclasses. 

3. Check log files in upgrade\data\cla 

Transfer data from production system 
After having performed the Customizing Upgrade, you can now start with transferring the 
reference data from the production system. Reference data are all tables except customized tables.  

Identify the reference data for your system and synchronize the versions. For details which tables 
must be copied, see chapter Overview Upgrade process 

The data is transferred with the following steps: 

� Define reference table 

� Perform transfer 

� Synchronize repository 

� Run after-takeover upgrade steps 

� Upgrade Classification 

Define reference tables 

1. Select folder Takeover in the Upgrade Tool and press the button Create Ref File. 

The Upgrade Tool will connect to the production database, identify all tables and synchronize 
the information with the predefined list (ref_tables). Only tables with data will be written to 
the file. 

Note: Depending on your specific configuration, adapt the preconfigured transfer type. 

For detail information on which tables should be copied, refer to the chapter Upgrade process 

2. To adapt the list, press Edit ref. file  
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Note you have to define, if it is a reference table for each table.  

3. Select OK to save the XML file (upgrade/data/ref_data_tab.xml). 

Perform transfer 

1. Save your customer Agile e6.0 dump. 

Oracle: Run the script exp_dmp in the upgrade/scripts directory (upgrade/cmd on windows 
machine). 

2. Press the Takeover button. 

The tables containing non-repository information are dropped in your customers dump. The 
tables will be copied from the defined production environment (which is defined in the 
production DB) into you customer dump.  

3. Check the log files in upgrade\ 

z Tko:_takeover.log 

Synchronize repository 

1. Adapt the physical table definition according to the table definition in Data View  

The table structure of the newly copied table will be adapted to an Agile e6.0 table structure. 

z AFTER TAKEOVER:run before-sync-scripts 
The command script upg07_sync_update.cmd will be executed. 
Check log files upg07%.log in the upgrade\log directory 
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z AFTER TAKEOVER >Synchronize_Repository.  
Data and log files will be written into the directory  upgrade\data\sync 
Check the file upgrade\log\errordetail.log for errors. 

z AFTER TAKEOVER > Run after-sync scripts 

Script Run after takeover  

1. Select Run after takeover scripts 

The command script upg15_prod3_postaction.cmd will be executed 

2. Check log files  upg15%.log in the directory in \upgrade\log 

The complete list of sql scripts is described in the annex 

3. Recreate own customer specific views, packages, procedures and triggers 

If you have implemented own views, packages, procedures or triggers please executes the sql 
scripts to create/replace  this objects in the database, so that they are valid. 

Special Upgrade: Classification  
Depending on your processes you have to execute one of the following possibilities. 

� Upgrade classification lists only 

� Upgrade complete classification including classes and attributes 

Please see upgrade process overview  for more information which option should be used.  

Upgrade classification lists only 

1. Select Classification (stage 2).  

It is required that the attributes are already migrated and so that only the classification lists 
will be updated. 
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2. Click Perform mapping. 

Upgrade complete classification 

If the customer has created new classes and attributes in the production system after the 
customization upgrade also classes, attributes and domain values must be copied and migrated  

Migrate classification data from the ATT concept to the new pool concept 

Note: Check parameters settings for the classification Upgrade ( for detailed information see 
Installation and Configuration manual) 

1. To start the migration please select action > Fileselection database > Classification 

2. Click the Execute Determine Merge conditions button. 

As result, the file merge_ctl. xml is created. This file contains so-called merge groups. All 
attributes mapped onto the same pool attribute are in the same merge group. 

3. Click the Execute Perform merge conditions button. 

The file merge_ctl. xml is read. Based on this information all objects and attributes are created 
or updated.  

4. Check the merge and log files.  

These files are located in upgrade\data\cla 

Migrate changes in attribute inheritance 

1. To start the migration, select action Filesetselection Database > Classification 
attributeinheritance 

2. Check  log files in upgrade\data\cla 
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Chapter 5  
Annex 

Convert XML files to HTML 
You can convert the XML files to HTML and view them with a browser. The batch file 
xml2html.bat creates HTML files for insert, update and delete. This function is available on 
Windows platforms only. 

Note: You need memory for approximately sixth times the XML file size! 

Run xml2html with one of the following parameter values which specify for module the HTML 
file will be created. 

The html-xml converter will create one file for insert, update and delete for each table.  

The batch job will run several hours. The jre allocates 512MB of memory. You can adjust the 
memory allocation by editing the file  

� Upgrade\cmd\upg_env.cmd  (PC) and 

� Upgrade/scripts/upg_env.sh 

Directory structure 
Directory Description 

cmd Windows 2000 shell scripts of the upgrade tool 

conf Configuration xml files 

conf\template Some templates of xml configuration files. These files are not used by the upgrade tool. 
The only Exception is the file ref_tables.xml. It will be read by the tool to recreate 
/conf/ref_tables.xml 

data This directory contains several subdirectories, each for a module – like BRW, EDB etc. 
For each module delete, insert and update xml files are created. After performing of 
these operations on the customer database, error xml file will be written. Additionally 
html files generated for a module will be saved here. A file customizing.log in this 
directory contains conflicts caused by customizing of the original dump 

data\dtv Dataview Upgrade files as described above are stored here. Please read carefully the file 
customizing.log because it contains user-exit conflicts. 

data\sync log files of the synchronize repository upgrade step are stored in this directory 

doc Upgrade tool documentation 

dumps Database dumps can be stored here. Dumps, which are imported / exported by shell 
scripts have to be stored in this directory 

lib Upgrade tool java executables 
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log Log files of all sql scripts and common application log files 

mssql\sql MS Sql Server sql-scripts 

ora\sql Oracle sql-scripts 

scripts Unix / linux shell scripts of the upgrade tool 

Shell scripts / Log files 

Here is a short description of all the shell scripts included in upgrade download package. 

Shell script Description Called SQL scripts 

chown_mssql.c
md 

A script to change the 
database owner in MS Sql 
Server 2000. 

-- 

convert_it.cmd Convert XML data file for a 
single table to HTML files. 
This script is called from 
xml2html.cmd. 

-- 

exp_dmp.cmd This script helps you to export 
oracle database to a dump file.

-- 

imp_dmp.cmd This script helps you to 
import oracle dump files. 

-- 

missing_f.cmd Create missing file groups in 
MS SQL Server. 

-- 

preaction_temp
late.cmd 

This file is for upgrade 
internal use only!. It is used as 
a template for creating the file 
preaction.cmd, which is 
needed if one or all upgrade 
steps are not executed within 
the standard graphical user 
interface. 

-- 

start_upg.cmd Start upgrade user interface. -- 

upg01_pre_clea
nlog.cmd 

Cleanup all log files within 
current upgrade project. 

-- 

upg02_setup.c
md 

Quick check of database 
connections – this can be 
performed in the standard 
user interface too. 

-- 

upg03_preactio
n_sql.cmd 

Run several SQL scripts 
depending on source, target 
and customer product 
versions. Called SQL scripts 

source: TRUNC_LVTABS.SQL > 
03_PREACTION_SQL.LOG 

source: GRANT_SELECT_T_CONSTRAINT.SQL 
source 

39 



Agile e6.0 

Shell script Description Called SQL scripts 

are saved in the file 
03_preaction_sql.log 

03_14_GRANT_SELECT_T_CONSTRAINT.LOG 

source: CRE_REP_EDB.SQL source 
03_12_CRE_REP_EDB.LOG 

target: GRANT_SELECT_T_CONSTRAINT.SQL > 
03_13_GRANT_SELECT_T_CONSTRAINT.LOG 

 

CRE_REP_EDB.SQL > 03_01_CRE_REP_EDB.LOG 

CLEANUP_C_ID_NULL.SQL > 
03_03_CLEANUP_C_ID_NULL.LOG 

ANA_LV.SQL > 03_04_ANA_LV.LOG 

 

<=CADIM: ORA3-4.SQL > 03_05_ORA3-4.LOG 

<=AXA SP 1: PST10P2TOP3.SQL > 
03_06_PST10P2TOP3.LOG 

<=AXA SP 1: ORA403-404.SQL > 03_07_ORA403-
404.LOG 

<=AXA SP 1: AXASP1_TO_SP2.SQL > 
03_08_AXASP1_TO_SP2.LOG 

<=AXA SP 2: GDM_UPD_MAS_FLD_ORA.SQL > 
03_09_GDM_UPD_MAS_FLD_ORA.LOG 

<=AXA SP 3: DTV405-406.SQL > 03_10_DTV405-
406.LOG 

<=AXA SP 3: UPD_T_SELECTION.SQL > 
03_11_UPD_T_SELECTION.LOG 

upg04_dtv_get.
cmd 

Get XML files for the step 
“DTV-Upgrade” in shell 
mode. 

-- 

upg05_dtv_upd
ate.cmd 

Proceed XML files for the step 
“DTV-Upgrade” in shell 
mode. 

-- 

upg06_sync_get
.cmd 

Run the step “Analyze 
repository” in shell mode. 

 

upg07_sync_up
date.cmd 

Run the step “Synchronize 
repository” in shell mode. 
Called SQL scripts are saved 
in the file 07_sync_update.log 

<= PLM5.x: before_sync.sql > 
07_01_before_sync.log 

upg08_postacti
on.cmd 

Run some SQL scripts, which 
are necessary after performing 
“Synchronize repository” 
upgrade step. Called SQL 
scripts are saved in the file 
08_postaction.log 

cleanup.sql > 08_02_cleanup.log 
cre_rep_edb.sql > 08_01_cre_rep_edb.log 

upg09_commo Generate XML files for several 
del_and_save_lvmodel.sql >  
09_01_del_and_save_lvmodel.log 
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Shell script Description Called SQL scripts 

n_get.cmd upgrade steps, one for each 
common PLM module. Called 
SQL scripts are saved in the 
file 09_common_get.log 

upg10_commo
n_update.cmd 

Proceed common PLM 
modules XML files. Called 
SQL scripts are saved in the 
file 10_common_update.log 

<=PLM5.x: edb_explorer.sql > 
10_edb_explorer.log 

<=PLM5.x: levind_in_stalut.sql > 
10_levind_in_stalut.log 

upg11_cla.cmd Upgrade PLM Classification. 
-- 

upg13_prod1_t
akeover.cmd 

Start a user interface to 
proceed with “Takeover 
production data”. Scripts 
upg14_prod2_rep_update and 
upg15_prod3_postaction have 
to be executed after that. 

-- 

upg14_prod2_r
ep_update.cmd 

Synchronize repository (this 
script includes all necessary 
preaction and postaction 
calls). 

SQL Files of upg07_sync_update.cmd and 
upg08_postaction.cmd are called again 

upg15_prod3_p
ostaction.cmd 

Run SQL scripts that are 
needed to be executed after 
takeover step. 

get_compile_view.sql > 
post_prod_compile_view.log 
get_compile_proc.sql > 
post_prod_compile_proc.log 
get_compile_trigger.sql > 
post_prod_compile_trigger.sql.log 
get_numvalue.sql > post_prod_numvalue.log 

upg_env.cmd Common upgrade settings, 
like Java, JRE, Path, etc. 

-- 

xml2drop.cmd Generates ora/ 
ref_data_tab.par and 
ora/ref_data_tab_drop.sql 
files for manually 
import/export of production 
tables. You have to configure 
which tables are relevant for 
the takeover step before. 

-- 

xml2html.cmd Converts generated XML files 
to HTML format for a 
module. Example: 
“xml2html.cmd dtv” Or 
“xml2html.cmd all” 

-- 

SQL scripts 
Here is a short description of SQL scripts delivered with the Agile Upgrade tool. All Script 
executions creates a log file in the upgrade/log directory which are named like the script itself with 
a prefix like pre_cst – which means it is a preaction script and it was executed on the customer 
dump. 
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ana_lv.sql Analyze LogiView Content in the customer dump. Please 
control the log file of this script as described in the manual. 

axasp1_to_sp2.sql Upgrade axalant sp1 to axalant sp2. 

before_sync.sql This script has to be executed before running the step 
“Synchronize Repository”. It is done by default with the 
standard upgrade configuration. It prepares the Table 
T_STA_LUT and drops triggers, because otherwise it’s 
impossible to insert rows in the involved tables. 

cleanup.sql This script cleans up some dump content and is executed 
automatically after the step “Synchronize Repository”. 

cleanup_c_id_null.sql This script cleans up some inconsistencies in the customer 
dump (like rows with negative C_ID values). It must be 
executed before DTV-upgrade. 

cre_plm_tbs.sql Creates missing oracle tablespaces. 

cre_plm_usr.sql Create a database user. This script need 2 Parameters: 
username and password 

cre_rep_edb.sql Create all schema object (tables, views, indexes, Packages, 
Triggers, Sequences etc.) and insert number server rows, the 
most of them already exist, so a lot of errors will be logged 
after executing this script. 

del_and_save_lvmodel.sql Delete standard LogiView content and save customized 
models with a prefix “SAVE-“. 

del_dtv.sql Truncate all internal DTV-tables. 

dtv405-406.sql Preaction script, has to be executed before DTV-upgrade for 
customer dump version <= axalant SP3. 

edb_explorer.sql Converts DTV explorer to Agile e6.0 EDB-explorer. This step 
is executed once after common modules upgrade. 

gdm_upd_mas_fld_ora.sql Preaction script has to be executed before DTV-upgrade for 
customer dump version <= axalant SP2. 

getoradrop.sql Get script “dropall.sql” which cleans up a complete database 
schema. 

get_compile_proc.sql Generates a script to recompile all packages/functions. 

get_compile_trigger.sql Generates a script to recompile all triggers. 

get_compile_view.sql Generates a script to recompile all views. 

get_numvalue.sql This script is executed in the production database and 
generates a file named “ set_numvalue.sql ” after takeover step. 
This file updates number server values in the customer 
database. 
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get_rebuildidx.sql This script generates a file named “ rebuildidx.sql ” to rebuild 
all indexes in a right tablespace of a schema. It has 5 
parameters for tablespaces: 
EDB EDB_IDX EDB_LOB EDB_TMP EDB_TMPIDX 

grant_select_t_constraint.sql This script grants a select on table T_CONSTRAINT for the 
customer Database. This permission is needed for constraint 
conversion. 

levind_in_stalut.sql This script is called automatically after “Synchronize 
Repository” and converts records in the table T_STA_LUT. It 
is needed only for upgrades form <= Eigner PLM to >= Agile 
e6.0. 

ora3-4.sql This preaction-script is called automatically if the customer 
dump is a CADIM dump. 

ora403-404.sql Preaction script, has to be executed before DTV-upgrade for 
customer dump version <= axalant SP1. 

Pst10P2ToP3.sql Preaction script, has to be executed before DTV-upgrade for 
customer dump version <= axalant SP1. 

reference_tabs.sql Is used by shell script del2xml. It creates an oracle parameter 
file for production data tables export. 

trunc_lvtabs.sql Truncate all LogiView tables. This script is executed on 
reference dumps only! 

update_customers_UIC.sql This script has to be executed on the customer dump before 
proceeding with upgrade 

upd_t_selection.sql This script is a workaround for incompatible changes for 
Table T_SELECTION in Eigner PLM5.0 This script is already 
executed on all reference dumps delivered with Agile Upgrade 
Tool. It will be automatically executed id necessary in the step 
“preaction-scripts” 

Folders Contents “upgrade/conf” and “upgrade/conf/template” 

Contents of the folder “upgrade/conf” 

ApplicationParameter.xml Global application configuration file 

brwDD.xml Configuration file for upgrade module 
BRW (Explorer) 

chgDD.xml configuration file for upgrade module CHG 
(Change Management) 

wflDD.xml configuration file for upgrade module WFL 
(Workflow) 

dodeDD.xml configuration file for upgrade module DODE 
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(Print Studio) 

dtvDD.xml configuration file for upgrade module DTV 
(Dataview Repository) 

edbDD.xml configuration file for upgrade module EDB 
(Agile PLM configuration) 

gdmDD.xml configuration file for upgrade module GDM 
(Office integration) 

gtmDD.xml configuration file for upgrade module GTM 

lgvDD.xml configuration file for upgrade module LGV 
(LogiView) 

special.xml Configuration file for the step “Synchronize 
Repository” 

specialreplace.xml A sample configuration file for special replace 
cases 

ref_tables.xml Configuration file for the upgrade step 
“Takeover production data” 

wfl_ctl.xml Configuration file for Workflow mapping 

cla_ctl.xml Configuration file for Classification Upgrade 
(Axalant 2000 to PLM5.x) 

cla_post_ctl.xml Configuration file for Classification Upgrade 
(Axalant 2000 to PLM5.x) 

insert.xsl, delete.xsl, update.xsl, upgrade.xsl XSL-Stylesheet for converting XML control 
files to HTML, used by xml2html.cmd script 

ref_data_tab_drop.xsl XSL-Stylesheet for generating SQL script, 
which drops production data tables in the 
customer dump. This style sheet is used by 
xml2drop.cmd 

ref_data_tab_par.xsl XSL-Stylesheet for generating table list clause 
for oracle EXP command, which can be use 
alternatively to transfer production data tables 
from production database. This style sheet is 
used by xml2drop.cmd 

cla_stl.xsl XSL-Stylesheet for Configuration file for 
Classification Upgrade (Axalant 2000 to 
PLM5.x), which generates a HTML output of 
performed mapping operations 
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dtv_dd.dtd Document type definition file for module 
control files 

 

Contents of the folder “upgrade/conf/template” 

  

ApplicationParameter.xml Upgrade tool settings file with standard values. 
Copy this file to upgrade/conf to reset the 
application settings. 

cla_ctl_with_multi_lang.xml Example for the classification control file (with 
multi-language definition of the attributes). 

cla_ctl_with multi_lang_repl.xml Example for the classification control file (with 
multi language definition of the attributes and 
additional fields for database replication). 

cla_ctl_with_repl.xml Example for the classification control file (with 
additional fields for database replication). 

special_move.xml Examples for the special case with table field 
moving. 

special_rename.xml Examples for the special case with table field 
renaming. 

Special.xml Default template. 

specialreplace.xml Examples for special replace cases. 

 

Configuration parameters 
PLM-Version The customer dump version 

Following values are valid: 

1 = CADIB/EDB 2.3.x 
2 = AXALANT SP1 
3 = AXALANT SP2 
4 = AXALANT SP3 
5 = PLM 5.0 
6 = Agile e6.0 

Logiview 
Timestamp 

A Timestamp 
All logiview items with a change date after this time point will be 
deleted. You can adapt this value manually. Following values are 
possible: 

CADIM/EDB 2.3.2 – 19990329094555 
CADIM/EDB 2.3#3 – 19990707174038 
CADIM/EDB 2.3#4 – 19990707174038 
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CADIM/EDB 2.3#5 – 20000329161725 
axalant2000 SP1 – 20001109140557 
axalant2000 SP2 – 20010723102350 
axalant2000 SP3 – 20011113092600 
axa2000 SP3 PA1 – 20020808110309 
Eigner PLM 5.0  - 20020830153411 

Classification –
Controlfile 

A file name of the control file for the customer dump in the 
present case 
Valid entries are: 

cla_ctl.xml 
cla_ctl_with_multi_lang.xml 
cla_ctl_with_multi_lang_repl.xml 
cla_ctl_with_repl.xml 

Database Language Language for the database dump. This influences the migration of 
the classification date.  
Values: German, English 
Default:  German 

Level Status that is set during classification upgrade for records in the 
tables t_cla_dat (pool attributes), t_group_dat(classes) 

Replication server The valid name of the database server should in case of an 
implemented database replication to the environment be 
migrated. 

Migration Rules 
Standard rules are available for insert, update und delete and these rules are verified during the 
comparison of the table contents.  

They can be overwritten by special definitions. 

Standard Rules for Delete 

Data records deleted in the standard are also deleted in the customer dump.  

Customer-specific 
dump 

EignerPLM CUSTOMER Action 

Selection - + Delete 

Standard Rules for Update 

Data records existing in CADIM/EDB or axalant that were deleted in the customer dump are not 
re-created. Existing data records are updated.  

The standard changes overwrite the customer changes.  

Customer-specific 
dump 

EignerPLM CUSTOMER Action 

Selection +  +  Update 

Special rules apply on field level to protect customer-specific changes. 
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Standard Rules for Insert 

Data records not existing in CADIM/EDB or axalant or in the customer dump are added.  

Customer-specific 
dump 

Agile e6.0 CUSTOMER Action 

Selection - -  

 

Special Rules 

Customer changes that will not be overwritten by standard changes are: 

z Field defaults and check strings 

z Customizings hints for fields containing user exits  

z Special handling for mask components   

z Replacements of  strings ... (-> specialreplace.xml) 
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